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Introduction 

Thank you for purchasing this digital camera. Everything you need to take quality digital photos and 

videos is included with your digital camera. 

Vivitar makes capturing those special moments as easy as possible.  

 

NOTE: Your digital camera needs an SD Memory card (up to 32GB) for normal use. 

SD Memory cards are not included and need to be purchased separately. 

 

Please read this manual carefully first in order to get the most out of your digital camera. 

 

 

 

 

What’s Included 

 

 

 

1) Digital Camera  

2) Lithium Battery 

3) USB cable  

4) Vivitar Experience Image Manager Software  

Installation CD  

5) Wrist Strap 

6) AC Charger 

 

 

 

 

 

NOTE: SD Memory card not included. 
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Parts of the Camera  

 

 

 

 

1. Power Button 9. Tripod Mount 

2. Shutter Button 10. Lens 

3. LCD Touch Screen 11. Battery Compartment 

4. LED Light Indicator 12. SD Memory Card Slot 

5. HOME Button  13. Wrist Strap Connector  

6. Self-Timer LED 14. Speaker  

7. Flash 15. MACRO Switch 

8. USB Slot 16. Microphone 

 

 

 

 

 



 
 

4 

Initial Camera Setup 

 

 

 

 

 

Installing the Battery  Installing the Memory Card 

 
Insert the battery (as shown). 

Make sure the lithium battery is fully 

charged before first use (see below for 

details). 

 

 

 
 SD Memory card (up to 32GB)  

needed for normal use. 

 

Turning On the Camera  Using the Camera 

 

      

 



 
 

5 

When powering the camera ON for the first time the camera will take you through the initial camera 

setup.  

 

1) Powering ON the Camera 

Lithium Battery: Installing and Charging 

 

Make sure the battery has been inserted properly into your digital camera, according to the polarity 

shown inside the battery compartment.  

Make sure to insert the lithium battery all the way into the battery compartment.  

(See photo above.) 

To Charge the Battery: 

Upon first use make sure the battery is fully charged. 

To charge the battery, insert the battery correctly into the camera and make sure the camera is 

powered off.  

Follow one of the steps below to charge the battery: 

A. Charge the battery using the USB connection cable (included) and your computer: 

 

- Connect one end of the USB cable into the USB port on your camera. 

- Connect the other end of the USB cable to the USB port on your computer. 

- The charge light will turn off when the battery is fully charged. 
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B. Charge the battery using the USB connection cable (included) and the AC Charger (included): 

 

- Connect one end of the USB cable into the USB port on your camera. 

- Connect the other end of the USB cable to the AC Charger and then plug the AC Charger into 

a power socket. 

- The charge light will turn off when the battery is fully charged. 

 

NOTE: 

Some camera features will not work if the battery power level is low. 

When the battery power is low the battery icon turns red and the camcorder automatically turns off 

a few seconds later.  

The energy status of the power is displayed on LCD as shown below:  

 Full battery power      Medium battery power    Low battery power   

 

SD Memory Card 

Make sure an SD card has been properly inserted into your camera. (SD card not included.) 

To properly insert the SD Card:  

 Push the SD card into the slot in the direction shown on the camera (see SD icon by the SD 

card slot).  

 Push the SD card until you hear a slight clicking sound. This indicates the SD card has been 

inserted correctly.  
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NOTE:  

 After the camera is powered on, an SD icon will appear on the LCD display. If you do not see 

the SD icon on the display, please check if the card was inserted properly. 

 Make sure the SD card is not locked (check the lock switch on the side of the SD card). If the SD 

card is locked this will prevent the camera from saving captured photos to the SD card. 

 
Power On 

Press the  POWER button to turn on the camera. 

 

 

2) Setting the Camera Language 

 You will first be prompted to select a language for the camera.  

The Language options appear. Drag up or down to scroll and view the menu options. 

 Select the language of your choice and tap SAVE & EXIT to confirm the selection. 

 After selecting a language, you will be asked if you would like to continue with the initial 

camera setup. The following message appears: “Continue with Camera Setup?”  

Tap “Yes” to continue or “No” to exit the setup. 

 

NOTE: If you select “No” and decide to leave the camera setup, the camera will be set to its 

default settings. These settings can be adjusted at any time manually through the menus of the 

camera. 
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3) Setting the Date and Time 

The next step in the initial camera setup is to set the date and time on the camera. 

 Drag up or down to scroll and view the Date and Time options. 

 Set the Date and Time as desired and tap SAVE & EXIT to confirm the selection and move to 

the next part of the camera setup. 

 

 

4) Setting the ViviLink Default Option 

Once the Date and Time have been set, you will be asked to set the default ViviLink destination for 

photos and videos taken with your camera.  

The ViviLink technology allows you to quickly and easily upload your camera’s photos and videos 

to the social networks of your choice with the accompanying software application. 

 First you will be asked to choose the default ViviLink social network for Photos.  

Drag up or down to scroll and view the ViviLink for Photos options and then tap SAVE & EXIT 

to confirm your selection. 

 Next you will be asked to choose the default ViviLink social network for Videos. Drag up or 

down to scroll and view the ViviLink for Videos options and then tap SAVE & EXIT to confirm 

your selection. 

 

Congratulations! Your camera is now ready to use. 
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Main Camera Modes 

Your camera has different modes for the various camera functions. 

You can switch modes by pressing the HOME button to the left of the LCD screen. The Home menu is 

shown on the LCD. Tap Camera, Video, or Playback to change your camera mode. 

 Photo Capture Mode 

 Use this mode to capture pictures with your camera. 

This is the default mode when the camera is powered ON. 

To take a picture, aim your camera as desired and press the Shutter button. 

The picture will be automatically saved to your camera’s memory card. 

To access the various menus for the Photo Capture Mode, tap MENU while in the Photo 

Capture Mode. 

 Video Capture Mode 

 Use this mode to capture videos with your digital camera. 

After turning on your camera, press the HOME button to open the Camera Mode options. 

Tap the Video icon to enter Video Capture Mode. 

To take a video, aim your camera as desired and press the Shutter button to start the 

record. A red record indicator will appear on the LCD screen while record is in progress. To 

stop the record, press the Shutter button again. The video will be automatically saved to 

your camera’s memory card. 

To access the various menus for the Video Capture Mode, tap MENU while in the Video 

Capture Mode. 

 

 Playback Mode (Photos & Videos) 

 Use this mode to view and manage the videos and photos seen on your camera - saved to 

your SD memory card. After turning on your camera, press the HOME button to open the 

Camera Mode options. Tap the Playback icon to enter the Playback Mode for photos and 

videos. You can scroll through the photos and videos that you’ve previously taken to view, 

edit or delete them as desired. 

To access the various menus for the Playback Mode for photos and videos, tap MENU 

while in the Playback Mode. 
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Camera Technical Specifications 

 

Image Sensor CMOS Sensor 

Image Resolution 

4608x3456(16M), 4000x3000(12M), 3648x2736 (10M), 

3264x2448 (8M), 3648x2048 (7MHD), 2592x1944 (5M), 

2048x1536 (3M), 1920x1080 (2MHD), 640x480 (VGA) 

Video Resolution 1280x720 (720P), 640x480 (VGA), 320x240 (QVGA) 

File Format JPEG (Photo) / AVI (Video) 

Internal Memory 16MB SDRAM (Buffer) - enough for 1 sample photo 

External Memory SD Memory card (up to 32GB) 

LCD Display 3.0 Inch TFT – Full Touch Screen 

Lens f=7.0mm, F3.0 

Zoom 4X Digital Zoom 

Exposure -3.0EV ~ +3.0EV 

White Balance Auto, Daylight, Cloudy, Fluorescent, Incandescent 

ISO Auto, 100, 200, 400 

Scene 
Auto, Scenery, Portrait, Night Scenery, Night Portrait, High 

Sensitivity, Beach  

Language English, French, Spanish, Portuguese, German, Italian, Russian, 

Polish, Greek 

Flash No Flash, Forced On, Auto Flash, Red Eye Reduction 

Self-Timer 2 seconds, 5 seconds, 10 seconds or Off 

Anti-Shake Yes 

Print Photos Yes 

Face Detect Yes 

Macro Switch Yes 

Interface USB 2.0 High Speed 

System Requirements 
Windows XP (SP3), Vista (SP1) and Windows 7 ; 

Mac OSX v10.5.x and above 

Battery Li-ion 650mAh(3.7V) 

Working Temperature 0~40C 
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Computer System Requirements 

 
WINDOWS 

To be able to download photos and videos to your PC, you will need the following minimum 

configuration:  

 MICROSOFT® Windows XP with Service Pack 3, Windows Vista with Service Pack 1 or Windows 7 

 Pentium® 4 processor (or above)  

 1 GB of RAM, with 250 MB of free hard disk space  

 16-bit Color monitor, 1024 X 768 recommended screen resolution  

 CD-ROM Drive 

 QuickTime® 6 or higher  

 MICROSOFT ® Internet Explorer 7 or higher 

 Windows Media Player 10 or higher  

 DirectX 9 or higher 

 Internet connection required 

 

 

MACINTOSH 

To be able to download photos and videos to your Macintosh, you will need the following minimum 

configuration:  

 Intel Processor running Mac OS X v10.5.x or later  

 1 GB RAM, 250 MB free hard disk space  

 Display: 1024 x 768 or higher-resolution monitor 

 CD-ROM Drive 

 QuickTime® 6 or higher  

 Internet connection required  
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Powering ON/OFF Your Digital camera 

 Make sure the batteries have been installed properly into your digital camera.  

 Make sure an SD card has been installed properly into your camera.  

 

 

Powering the camera ON 

Press the  Power button to turn your camera ON.  

 After powering on, the camera emits a sound and the LED light turns on briefly. 

 The LCD touch screen turns on with your camera in Photo Capture mode to start. 

 

 

Powering the camera OFF 

While the camera is on, you can press the  Power button again at any point to turn your camera 

OFF. You will see a “Goodbye” splash screen and then the camera will power off completely.  

Alternatively, you can press the HOME button and then tap the Power Off icon. Tap ‘Yes’ to select to 

power off the digital camera. 

 

NOTE: Your digital camera also has an Auto Power Off feature that automatically turns off your 

camera after a specific period of time that your camera is left idle. The Auto Power Off time can be set 

from the Setup/Auto Off menu settings. 
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Changing Camera Mode  

Your camera has three main modes: 

1) Photo Capture Mode - Use this mode to capture photos with your camera. 

2) Video Capture Mode - Use this mode to capture videos with your camera. 

3) Playback Mode (for photos and videos) - Use this mode to view the photos and videos you 

have already taken with your camera. 

 

 When the camera is first powered ON, the Photo Capture Mode will be active.  

 The icons that appear on the LCD screen are the best default settings so that you can begin to 

capture and enjoy clear quality photos. 

 

To change the active camera mode: 

 Make sure the camera is powered ON. 

 Press the HOME. 

 Tap one of the following icons to select the active camera mode: 

 Camera 

  Video 

 Playback 

 

 When in Photo Capture Mode, this icon will display on the top-left corner of the LCD display  

 

 When in Video Capture Mode, this icon will display on the top-left corner of the LCD display  

 

 When in Playback Mode, this icon will display on the top-left corner of the LCD display  
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Navigating the Menus 

You camera includes the following menus: 

 Home Menus 

 Camera Mode Menus 

 Camera Setup Menus 
 

You can access and change camera settings by the following methods: 

1) Icons on the LCD Touch Screen: 

While in the Photo, Video, and Playback Modes in Preview/Standby: You can toggle between the 

menu options each time you tap a menu icon that appears on the LCD screen until you see the 

desired option. 

2) Menu Screens: 

Enter the menu screens and select the desired option. 

Please see information below for more details regarding this method. 

 

Home Menus 

The Home screen menu allows you quick access to the camera modes and settings as well as to the 

photo slideshow and the power off. 

1) Press the HOME button located on the left side of the LCD touch screen. 

2) The following menu options appear on the Home screen: 

 

 

 Camera Tap to enter Photo Capture Mode 

 Video Tap to enter Video Capture Mode 

 Playback Tap to enter Playback Mode 
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 Setup Tap to enter Camera General Settings 

 Slide Show Tap to begin Photo Slide Show 

 Power Off Touch to Power off your digital camera 

 

 
 

 Camera Mode Menus 

Each camera mode has a set of menus specific to that mode. 

1) Enter the Main Menu Screen from Video Capture, Photo Capture or Playback Mode: 

 Tap MENU as seen on the bottom left of the LCD touch screen to open the menus for the 

current mode. 

2) Select a Main Menu Option:  

 Drag up or down to scroll and view the main menus. 

 To select a menu, tap the desired menu icon to open the various options for that menu. 

NOTE: To exit the menu screen without selecting a menu, tap  Return and return to the current 

mode. 

3) Selected a Sub-Menu Option: 

 Drag up or down to scroll and highlight the desired menu option. 

 Tap SAVE & EXIT to confirm and select the highlighted menu option. 

NOTE: Changes made to these options will remain as is until you decide to change them again at a 

later time. 

4) The selected option icon appears on the touch LCD screen.  

NOTE: Some menu options are single-use functions that are not remembered by the camera and 

do not display an icon on the LCD screen. 

 
 

For more details regarding specific menus, please refer to the menu information listed for each mode. 
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 Camera Setup Menus 

The general settings for your digital camera can easily be changed at any time. 

1) Press the HOME button to the right of the LCD touch screen to open the Home screen options. 

2)  Tap the Setup icon to enter the menu options for your camera general settings. 

3) Select a Setup Option:  

 Drag up or down to scroll and view the main Setup menus. 

 To select a Setup menu, tap the desired menu icon to open the various options for that menu. 

NOTE: To exit the Setup screen without selecting a menu, tap  Return and return to the 

Home Menu screen. 

4) Selected a Setup Sub-Menu Option: 

 Drag up or down to scroll and highlight the desired menu option. 

Alternatively, simply tap and highlight the desired option. 

 Tap SAVE & EXIT to confirm and select the highlighted menu option. 

NOTE: Changes made to these options will remain until you decide to change them again at a later 

time. 

5) The selected option icon appears on the touch LCD screen.  

NOTE: Some menu options are single-use functions that are not remembered by the camera and 

do not display an icon on the LCD screen. 

 

For more details regarding specific Setup menus, please refer to the ‘Setup Menu’ section of this manual. 
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Camera Options: Flash, Macro Switch 

Flash Options 

There are several Flash options available on your camera. The options appear on the Photo Capture 

Mode LCD screen in sequence.  

To change the Flash mode, tap the Flash icon on the left side of the LCD screen until you arrive at 

your desired setting. 

Important: When using Flash, stand between 8 to 10 feet away from the scene you would like to 

capture. 
 

NOTE: The MACRO mode must be turned OFF when you want to use the Flash.  

 To turn off MACRO mode: Slide the MACRO Switch down to the mountain icon .  

 When MACRO is OFF, the mountain icon  appears on the LCD display. 

 

Flash Type Description 

  

Forced Off (Default) 

 No flash will appear. 

 Use this when you do not want to activate Flash. 

NOTE: A ‘Turn On Flash’ message appears when the camera 

detects a need for flash. When this message appears, it is 

recommended to press the Flash/Up button and select one of the 

flash options: Auto Flash, Forced On or Red-Eye Reduction. 

A  

Auto Flash 

 

 When you want the camera to determine if Flash is needed, select 

Auto Flash.  

 The flash will automatically turn on according to the lighting 

conditions. 

 When the LED light stops blinking, the Flash is ready for use. 

NOTE: In some cameras, an initial flash appears to test your 

lighting conditions. If flash is needed, a second flash will appear 

upon taking the photo. 

  

Forced On 

 The flash is enabled for each photo.  

 NOTE: If you use this option in a well lit environment, your photo 

may be appear too bright/light (overexposed). 

 

Red Eye Reduction 

 Eliminates the red-eye effect in a photo caused by flash. 
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Macro Option 

Your digital camera contains a Macro Switch that allows you to manually enable or disable the Macro 

mode on your camera. While using the Macro mode, you can capture images at close range (10 ~ 25 

cm). 

 

MACRO MODE ON:  

To turn the Macro mode ON, slide the Macro Switch on the side of your camera UP to the flower icon 

.  

 When enabled, the Macro mode allows your digital camera to focus on an object that is close to the 

camera.  

 The flower icon  will appear on the LCD and indicates that the Macro mode is ON.  

 

 

 

MACRO MODE OFF: 

To turn the Macro mode OFF slide the Macro Switch on the side of the camera DOWN to the mountain 

 icon.  

 The mountain  icon will appear on the LCD display. 

 When Macro mode is off, images can be captured from 1.5m - ∞ (infinity). 

 

NOTE: The Macro mode must be turned OFF when you want to use the following features: 

Flash, Face Detect, and Smile Capture.  

Not all cameras included these features. Refer to the ‘Camera Specifications’ section to view the 

features included with this camera. 
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Photo Capture Mode 

The Photo Capture Mode allows you to capture pictures with your digital camera. 

After powering on your digital camera, by default the Photo Capture Mode displays. 

 To enter Photo Capture Mode: 

 Press the HOME button. 

 Tap the  Camera icon to enter Photo Capture Mode. 

 

 

Taking a Picture 
 

1) While in Photo Capture Mode, use the LCD display to direct the camera at the scene you would like 

to capture. 

2) You can magnify your subject up to 4 times using the digital zoom while capturing your photos and 

recording your videos. 

Tap the T icon to zoom in on the object and tap the W icon to zoom back out.  

The following Digital Zoom Indicator appears on the right side of the LCD screen: 

  

The indicating bar moves up when you zoom in (T) and moves down when you zoom out (W). 

3) Press the Shutter button on the top of the digital camera to take the picture.  

4) The picture is automatically saved to the SD memory card.  
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Photo Capture Mode Menus 

The following are the menus that appear in your camera’s Photo Capture Mode: 

 

 Scene  AWB (White Level)  

 Resolution  Color Effect 

 Quality  Sharpness 

 ViviLink  Exposure 

 Self Timer   ISO 

 Anti-Shake  Metering 

 Face Detect  Multi Shot 

 

Reminder: While in Capture Mode, you can also change settings by tapping icons that appear on the 

LCD touch screen to toggle between the menu options until you arrive at your desired setting. 

 

 Scene Menu 

The Scene Menu allows you to choose scene settings that let your camera to adapt properly to your 

current environment. 

The Scene Menu Options include: 

 Auto  Night Portrait 

 Scenery  High Sensitivity 

 Portrait  Beach 

 Night Scenery  

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Scene menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 
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5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top left side of the LCD screen, below the Photo Capture Mode icon. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Resolution Menu 

The Resolution menu allows you to choose the desired size of the images taken by your camera. Keep 

in mind that images with a higher resolution will also take up more of your camera’s memory. 

The Resolution Menu Options include: 

16M 4608x3456  

12M 4000x3000 

10M 3648x2736 

8M 3264x2448 

7M HD 3648x2048 

5M 2592x1944 

3M 2048x1536 

2M HD 1920x1080 

VGA 640x480 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Resolution menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  
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6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top left of the LCD screen, to the right of the Photo Capture Mode icon. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Quality Menu 

The Quality menu allows you to select the desired quality level of the images taken by your camera. 

Keep in mind that images with a higher image quality level will also take up more memory on your 

camera. 

The Quality Menu Options include: 

      Normal 

  Fine 

  Super Fine 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Quality menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 
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 ViviLink Menu (for Photos) 

The ViviLink technology allows you to quickly and easily upload your camera’s photos and videos to 

the social networks of your choice with the accompanying Vivitar Experience Image Manager 

application. 

The ViviLink for Photos Menu Options include: 

  Facebook 

  Twitgoo 

  Twitpic 

 Photobucket 

 Flickr 

 MySpace 

 Picasa Albums 

N None 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the ViviLink menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top left side of the LCD screen, below the Photo Capture Mode and 

Scene icons. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 
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NOTE:  

 The ViviLink feature is deactivated by default. A ViviLink destination will only be assigned to a 

photo or video if you have previously set it during the initial camera setup or manually set it 

from this menu or from the ViviLink menu in Playback Mode. Alternatively, you can also 

change the ViviLink by tapping the ViviLink icon on the LCD screen – which then toggles 

through the ViviLink options. 

 The selected ViviLink destination icon appears on the captured image when viewed in 

Playback Mode. 

 

 

 Self-Timer Menu 

The Self-Timer menu allows you to set a delay between the time that the camera’s Shutter button is 

pressed and the actual capture of the picture.  

This is an optimal feature if you don’t just want to take the picture but would also like to be in the 

picture yourself. Set the desired Self-Timer delay, press the Shutter button on your camera and 

position yourself in front of the camera as desired. 

The Self-Timer Menu Options include: 

2S Timer 2 seconds delay 

5S Timer 5 seconds delay 

10S Timer 10 seconds delay 

Off No delay 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Self-Timer menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  
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6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top of the LCD screen. (NOTE: The ‘Off’ option does not appear on the 

LCD.) 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Anti-Shake Menu 

The Anti-Shake feature reduces image corruption that can be caused by movement of the camera 

while capturing the image. 

The Anti-Shake Menu Options include: 

ON  Activates the Anti-Shake feature 

OFF  Disables the Anti-Shake feature 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Anti-Shake menu icon to open the menu options. 

3) Tap ‘ON’ to activate the Anti-Shake feature. 

Tap ‘OFF’ to disable the Anti-Shake feature. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 
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 Face-Detect Menu 

The Face Detect feature when set to ‘On’ allows the camera to use a subject’s face as the basis for 

balancing the other colors and focus in the digital camera’s display. This feature is meant to ensure 

that the color and focus of your pictures will be consistently sharp and high-quality. 

 

To properly use the Face Detect option, please ensure the following: 

 MACRO Mode OFF - Face Detect will not work if the camera is in Macro mode.  

To turn MACRO Mode OFF: Push the Macro Switch on the side of the camera down for the 

mountain  icon to appear on the LCD. 

 Anti-Shake ON – Ensure that the Anti-Shake option is set to ‘On’. The Anti-Shake option is ‘On’ by 

default when you start using your camera and assists you in properly focusing the image. 

 Distance from the camera – The subject’s face must be no further than 8 to 9 feet (3.5 meters) 

from the camera and the face must cover at least 20% (1 / 5th) of the picture previewed on the LCD 

screen. 

 Facing the camera – The face of the subject(s) you are photographing must be facing the camera 

and must hold the pose for at least 4 to 5 seconds until the green square(s) appears around the 

subject’s face. 

 

The Face Detect Menu Options include: 

ON  Activates the Face Detect feature 

OFF  Disables the Face Detect feature 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Face Detect menu icon to open the menu options. 

3) Tap ‘ON’ to activate the Face Detect feature. 

Tap ‘OFF’ to disable the Face Detect feature. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  
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6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 AWB (White Level) Menu 

Using the White Level feature your camera can adjust to the coloring of the captured images 

depending on the type of light source in the current environment.  

Properly adjusting the White Level setting to match your current environment allows the camera to 

properly balance the colors in the images that are taken with your camera. 

The White Level Menu Options include: 

  Auto 

  Daylight 

  Cloudy 

  Fluorescent 

 Incandescent 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the AWB menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 
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 Color Effect Menu 

You can choose to add a color effect to the images taken with your camera. 

The Color Effect Menu Options include: 

 Standard 

 Sepia 

  Monochrome 

  Vivid 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Color Effect menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Sharpness Menu 

You can set the level of sharpness in the images taken with your camera. The sharpness level dictates 

if the edges of objects in the image are more or less distinct. 

The Sharpness Menu Options include: 

 Soft 

 Normal 

 Sharp 
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1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Sharpness menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Exposure Menu 

The Light Exposure setting helps you control the amount of light that enters your camera’s lens. This 

setting should be adjusted when the environment is lighter or darker than normal.  

 When the environment has more light than is needed, reduce the exposure setting (by using the 

negative - count) to reduce the amount of light allowed into the lens by your camera. 

 If the environment has less light (darker) than is needed, increase the exposure setting (by using 

the positive + count) to increase the amount of light allowed into the lens by your camera. 

The Exposure Menu Options include: 

 +3 Lightest  -1 Dark 

 +2 Lighter  -2 Darker 

 +1 Light  -3 Darkest 

 0 Normal   

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Exposure menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 



 
 

30 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 ISO Menu 

The ISO menu allows you to set the level of sensitivity that your camera has to light in the surrounding 

environment. When the ISO level is increased, the image sensor in your camera will be more sensitive 

to light and allow you to capture images in lower-light situations. The higher sensitivity to light however, 

may reduce the quality of the images that are taken. 

When the ISO is reduced, the image sensor in your camera will be less sensitive to light and will 

optimize the image quality in environments with bright lighting. 

The ISO Menu Options include: 

 ISO Auto 

 ISO 100 

 ISO 200 

 ISO 400 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the ISO menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 



 
 

31 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Metering Menu 

The Metering setting will affect how your camera focuses when capturing an image. Depending on 

your selection, the camera will be more sensitive to focusing on particular areas in the display and 

adjust the image color and lighting accordingly. 

Center – Averages the light metered from the entire frame, but giving greater weight to the subject in 

the center 

Multi – Used in standard conditions the camera divides and adjusts the settings of the image into 

several zones for light metering such as complex light conditions, position of subject, brightness, 

background, direct light and scenes 

Spot – Meters the area within the spot point frame at the center of the LCD to set the exposure on the 

subject in the center of the monitor. 

The Metering Menu Options include: 

 Center 

 Multi 

 Spot 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Metering menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 
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 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 

 Multi Shot Menu 

When enabled, the Multi SnapShots feature allows you to take five rapid snapshots in a row with a 

single click of the Shutter button.  

This feature can be effective when trying to capture a particular moment in a sporting event or other 

scenes with quick movements. 

The Multi Shot Menu Options include: 

ON  Activates the Multi Shot feature 

OFF  Disables the Multi Shot feature 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Multi Shot menu icon to open the menu options. 

3) Tap ‘ON’ to activate the Multi Shot feature. 

Tap ‘OFF’ to disable the Multi Shot feature. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Photo Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top left corner of the LCD screen – replacing the Photo Capture Mode 

icon. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 
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Photo Playback Mode 

 The Playback Mode allows you to review and edit photos and videos that you’ve already taken with 

you camera. 

 When you first turn on the camera, the camera will be in Photo Capture Mode by default.  

 Press the HOME button to open the Camera Mode options.  

  Tap the Playback icon to enter the Playback Mode for photos and videos. 

 The latest captured image appears on the LCD screen.  

If there are no images stored, a message (No File) appears. 

 

 

Viewing Photos on Your Camera 
 

1) Select your Photo: 

 Once in Playback Mode, view each of your captured images by sliding your finger left or right 

across the LCD touch screen.  

Scroll through the images on your camera’s memory card until you find the photo you would 

like to view. 

 Each captured image (video and photo) is displayed on the LCD screen.  

 Photos appear with a ‘JPG’ icon on the top left of the LCD screen. 

  

2) Zooming In/Out of your selected Photo:: 

 Tap the Zoom In icon  to zoom in and magnify the selected photo.  

Slide your finger on the LCD screen in the direction you would like to navigate around the 

photo. 

 Tap the Zoom Out icon  down to Zoom Out of the selected photo. 
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Thumbnail View 

Easily navigate and select the video or photo you wish to view by using the Thumbnail View. 

The images on your camera will be displayed in a 3 X 3 matrix where you can use easily navigate to 

scroll and select images from the thumbnails. 

1)  Tap the Thumbnail View icon on the LCD to open the Thumbnail View.  

2) All images (videos and photos) saved on your on your SD Memory card appear in the Thumbnail 

View. 

3) Drag up or down to scroll through the Thumbnail images. 

4) Tap a Thumbnail to select and enlarge the image to full screen size. 

 

 

Photo Playback Mode LCD Screen Functions 

While in Photo Playback Mode, you can easily control the camera features for each image. 

 

 Delete (Selected File) 

1) Press the HOME button and tap the Playback icon to enter the Playback Mode. 

2) Select a photo. 

3) To delete the selected photo: 

 Tap the  Delete icon located on the left side of the LCD screen. 

 A ‘Delete Current’ window appears. 

 Tap ‘YES’ to automatically delete the selected photo. 

 Tap ‘NO’ to return to Playback Mode without deleting the selected photo. 

 

 

 ViviLink 

The ViviLink technology allows you to quickly and easily upload your camera’s photos and videos to 

the social networks of your choice with the accompanying Vivitar Experience Image Manager 

application.  

1) Press the HOME button and tap the Playback icon to enter the Playback Mode. 

2) Select a photo. 

To assign a ViviLink destination to your photo: 
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Tap the ViviLink icon located on the top center of the LCD screen. 

Toggle through the ViviLink options until the desired ViviLink icon appears. 

The ViviLink for Photos options include: 

  Facebook 

  Twitgoo 

  Twitpic 

 Photobucket 

 Flickr 

 MySpace 

 Picasa Albums 

N None 

 
 

 Print Photos 

You can use the Print Photos menu to print the photos that are on your camera directly to a Pictbridge 

compatible printer. 

1) Press the HOME button and tap the Playback icon to enter the Playback Mode. 

2) Scroll through your pictures and find the one you would like to print. 

3) Tap the Print icon located on the left under the JPG icon. 

4) You will be asked to connect the camera to the Pictbridge printer. 

5) Connect the USB cable provided in the package from the camera to the Pictbridge port of the 

printer. 

6) Once connected, follow the instructions on the printer to proceed with the printing process. 

 

 

 Thumbnail View 

1) Press the HOME button and tap the Playback icon to enter the Playback Mode. 

2) Tap the Thumbnail View icon located under the Delete icon to view all captured videos and photos 

in Thumbnail view. 
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Photo Playback Mode Menus 

The following are the menus that appear in your digital camera’s Photo Playback Mode: 

  Delete 

  ViviLink 

  Rotate 

  Crop 

 

 Delete Menu  

While in the Playback Mode, you can delete selected videos or photos from your digital camera 

through the Delete menu. 

1) Press the HOME button and tap the Playback icon to enter the Playback Mode.  

2) Tap MENU located at the bottom left corner of the LCD screen to open the Main Menu Screen for 

the current mode. 

3) Tap the Delete menu icon to open the menu options. 

 A ‘Delete Current’ window appears. 

 Tap ‘YES’ to automatically delete the selected photo. 

 Tap ‘NO’ to return to Playback Mode without deleting the selected photo. 

 

 

 ViviLink Menu (for Photos) 

The ViviLink technology allows you to quickly and easily upload your camera’s photos and videos to 

the social networks of your choice with the accompanying Vivitar Experience Image Manager 

application. 

The ViviLink for Photos Menu Options include: 

  Facebook 

  Twitgoo 

  Twitpic 

 Photobucket 
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 Flickr 

 MySpace 

 Picasa Albums 

N None 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the ViviLink menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Playback Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top center of the LCD screen. 

 

 
 
 

 Rotate Menu 

Use this menu to rotate the pictures that you’ve taken with your camera. 

1) View the photo you would like to rotate. 

2) Tap MENU to open the Main Menu Screen for the current mode. 

3) Tap the Rotate menu icon. 

4) Tap the  Rotate icon to rotate the photo each time by 90 clockwise 

5) To save, tap the  Return icon. 

6) The selected picture will now appear rotated in the Playback Mode. 
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 Crop Image Menu 

You can crop any picture on your camera with the Crop feature. 

1) View the photo you would like to crop. 

2) Tap MENU to open the Main Menu Screen for the current mode. 

3) Tap the Crop menu icon. 

4) A blue crop rectangle appears on the photo. 

5) Tap the +  or –  icon to enlarge or shrink the crop box to the desired size. 

6) To define the desired crop area: 

Slide your finger up, down, left or right to navigate the area of the photo you wish to crop. 

7) When you are ready to crop, tap the  Crop icon. 

If you would like to exit without cropping, tap the  Return icon button. 

8) If you selected to save, the cropped picture now appears as a new picture to your memory card. 
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Video Capture Mode 

The Video Capture Mode allows you to capture videos with your digital camera. 

When the camera is first powered ON, the camera will be in Photo Capture Mode.  

 After turning on your camera, press the HOME button to open the Camera Mode options.  

Tap Video to enter Video Capture Mode.  

 

Taking a Video 

1) While in Video Capture Mode use the LCD display to direct the camera at the scene you would like 

to capture. 

2) You can magnify your subject up to 4 times using the digital zoom while capturing your photos and 

recording your videos. 

Tap the T icon to zoom in on the object and tap the W icon to zoom back out.  

The following Digital Zoom Indicator appears on the right side of the LCD screen: 

 

The indicating bar moves up when you zoom in (T) and moves down when you zoom out (W). 

3) Press the Shutter button on the top of the digital camera to START the video capture. 

4) A red, blinking icon appears at the top of the LCD screen indicating that the record is in progress. 

On the top right, the recording time appears, indicating the amount of elapsed time as the video is 

being captured.  

5) To STOP the video record, press the Shutter button again.  

6) The video is automatically saved to the camera’s SD memory card.  
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Video Capture Mode Menus 

The following are the menus that appear in your camera’s Video Capture Mode: 

 

 Scene  Color Effect 

 Resolution  Sharpness 

 Quality  Exposure 

 ViviLink  ISO 

 AWB (White Level)  Metering 

 

Reminder: While in Capture Mode, you can also change settings by tapping icons that appear on the 

LCD touch screen to toggle between the menu options until you see the desired option. 

 

 Scene Menu 

The Scene Menu allows you to choose scene settings that let your camera to adapt properly to your 

current environment. 

The Scene Menu Options include: 

 Auto  Night Portrait 

 Scenery  High Sensitivity 

 Portrait  Beach 

 Night Scenery  

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Scene menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  
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6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top left side of the LCD screen, below the Video Capture Mode icon. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Resolution Menu 

The Resolution menu allows you to choose the desired size of the images taken by your camera. Keep 

in mind that images with a higher resolution will also take up more of your camera’s memory. 

The Resolution Menu Options include: 

720P 1280x720 

VGA 640x480 

QVGA 320x240 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Resolution menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top left of the LCD screen, to the right of the Video Capture Mode icon. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 
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 Quality Menu 

The Quality menu allows you to select the desired quality level of the images taken by your camera. 

Keep in mind that images with a higher image quality level will also take up more memory on your 

camera. 

The Quality Menu Options include: 

      Normal 

  Fine 

  Super Fine 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Quality menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 ViviLink Menu (for Videos) 

The ViviLink technology allows you to quickly and easily upload your camera’s photos and videos to 

the social networks of your choice with the accompanying Vivitar Experience Image Manager 

application. 
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The ViviLink for Videos Menu Options include: 

  YouTube 

  Photobucket 

  Flickr 

N None 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the ViviLink menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top left side of the LCD screen, below the Video Capture Mode and 

Scenery icons. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 

NOTE:  

 The ViviLink feature is deactivated by default. A ViviLink destination will only be assigned to a 

photo or video if you have previously set it during the initial camera setup or manually set it 

from this menu or from the ViviLink menu in Playback Mode. Alternatively, you can also 

change the ViviLink by tapping the ViviLink icon on the LCD screen – which then toggles 

through the ViviLink options. 

 The selected ViviLink destination icon appears on the captured image when viewed in 

Playback Mode. 
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 AWB (White Level) Menu 

Using the White Level feature your camera can adjust to the coloring of the captured images 

depending on the type of light source in the current environment.  

Properly adjusting the White Level setting to match your current environment allows the camera to 

properly balance the colors in the images that are taken with your camera. 

The White Level Menu Options include: 

  Auto 

  Daylight 

  Cloudy 

  Fluorescent 

 Incandescent 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the AWB menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 
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 Color Effect Menu 

You can choose to add a color effect to the images taken with your camera. 

The Color Effect Menu Options include: 

 Standard 

 Sepia 

  Monochrome 

  Vivid 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Color Effect menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Sharpness Menu 

You can set the level of sharpness in the images taken with your camera. The sharpness level dictates 

if the edges of objects in the image are more or less distinct. 

The Sharpness Menu Options include: 

 Soft 

 Normal 

 Sharp 
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1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Sharpness menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Exposure Menu 

The Light Exposure setting helps you control the amount of light that enters your camera’s lens. This 

setting should be adjusted when the environment is lighter or darker than normal.  

 When the environment has more light than is needed, reduce the exposure setting (by using the 

negative - count) to reduce the amount of light allowed into the lens by your camera. 

 If the environment has less light (darker) than is needed, increase the exposure setting (by using 

the positive + count) to increase the amount of light allowed into the lens by your camera. 

The Exposure Menu Options include: 

 +3 Lightest  -1 Dark 

 +2 Lighter  -2 Darker 

 +1 Light  -3 Darkest 

 0 Normal   

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Exposure menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 
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4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 ISO Menu 

The ISO menu allows you to set the level of sensitivity that your camera has to light in the surrounding 

environment. When the ISO level is increased, the image sensor in your camera will be more sensitive 

to light and allow you to capture images in lower-light situations. The higher sensitivity to light however, 

may reduce the quality of the images that are taken. 

When the ISO is reduced, the image sensor in your camera will be less sensitive to light and will 

optimize the image quality in environments with bright lighting. 

The ISO Menu Options include: 

 ISO Auto 

 ISO 100 

 ISO 200 

 ISO 400 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the ISO menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 
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 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 
 
 

 Metering Menu 

The Metering setting will affect how your camera focuses when capturing an image. Depending on 

your selection, the camera will be more sensitive to focusing on particular areas in the display and 

adjust the image color and lighting accordingly. 

Center – Averages the light metered from the entire frame, but giving greater weight to the subject in 

the center 

Multi – Used in standard conditions the camera divides and adjusts the settings of the image into 

several zones for light metering such as complex light conditions, position of subject, brightness, 

background, direct light and scenes 

Spot – Meters the area within the spot point frame at the center of the LCD to set the exposure on the 

subject in the center of the monitor. 

The Metering Menu Options include: 

 Center 

 Multi 

 Spot 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the Metering menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 
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 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Video Capture Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the bottom of the LCD screen. 

The setting is saved by your camera until you manually change the setting or restore the camera’s 

default factory settings. 

 

 

Video Playback Mode 

 The Playback Mode allows you to review and edit photos and videos that you’ve already taken with 

you camera. 

 When you first turn on the camera, the camera will be in Video Capture Mode by default.  

 Press the HOME button to open the Camera Mode options.  

  Tap the Playback icon to enter the Playback Mode for photos and videos. 

 The latest captured image appears on the LCD screen.  

If there are no images stored, a message (No File) appears. 

 

Playing Videos on Your Camera 

1) Select your Video: 

 Once in Playback Mode, view each of your captured images by sliding your finger left or right 

across the LCD touch screen.  

Scroll through the images on your camera’s memory card until you find the video you would 

like to view. 

 Each captured image (video and photo) is displayed on the LCD screen.  

Videos appear with an ‘AVI’ icon on the top left of the LCD screen.  

2) Play your selected video: 

 Tap the Play icon in the center of the LCD screen to START playing the video. 

 Tap the LCD screen to PAUSE the video and tap again to continue playing and pausing as 

needed. 

 To fully STOP the video and restore the icons to the LCD, press the Shutter button.  

NOTE: While the Video is playing, all the icons on the top section of the LCD disappear. 
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Thumbnail View 

Easily navigate and select the video or photo you wish to view by using the Thumbnail View. 

The images on your camera will be displayed in a 3 X 3 matrix where you can use easily navigate to 

scroll and select images from the thumbnails. 

1)  Tap the Thumbnail View icon on the LCD to open the Thumbnail View.  

2) All images (videos and photos) saved on your on your SD Memory card appear in the Thumbnail 

View. 

3) Drag up or down to scroll through the Thumbnail images. 

4) Tap a Thumbnail to select and enlarge the image to full screen size. 

5) Once the selected video is full size you can play and view the video. 

 

 

 

Video Playback Mode LCD Screen Functions 

While in Video Playback Mode, you can easily control the camera features for each image. 

 

 Delete (Selected File) 

1) Press the HOME button and tap the Playback icon to enter the Playback Mode. 

2) Select a video. 

3) To delete the selected video: 

 Tap the  Delete icon located on the left beneath the AVI icon. 

 A ‘Delete Current’ window appears. 

 Tap ‘YES’ to automatically delete the selected video. 

 Tap ‘NO’ to return to Playback Mode without deleting the selected video. 

 

 

 ViviLink 

The ViviLink technology allows you to quickly and easily upload your camera’s photos and videos to 

the social networks of your choice with the accompanying Vivitar Experience Image Manager 

application.  

1) Press the HOME button and tap the Playback icon to enter the Playback Mode. 
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2) Select a video. 

3) To assign a ViviLink destination to your video: 

Tap the ViviLink icon located on the top center of the LCD screen. 

Toggle through the ViviLink options until the desired ViviLink icon appears. 

The ViviLink for Videos options include: 

  YouTube 

  Photobucket 

  Flickr 

N None 

 

 

 Thumbnail View 

1) Press the HOME button and tap the Playback icon to enter the Playback Mode. 

2) Tap the Thumbnail View icon located under the Delete icon to view all captured videos and photos 

in Thumbnail view. 

 

 

 

Video Playback Mode Menus 

The following are the menus that appear in your digital camera’s Video Playback Mode: 

  Delete 

  ViviLink 

 

 Delete 

While in the Playback Mode, you can delete the selected video or photo from your digital camera 

through the Delete menu. 

1) Press the HOME button and tap the Playback icon to enter the Playback Mode.  

2) Tap MENU located at the bottom left corner of the LCD screen to open the Main Menu Screen for 

the current mode. 

3) Tap the Delete menu icon to open the menu options. 
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 A ‘Delete Current’ window appears. 

 Tap ‘YES’ to automatically delete the selected video. 

 Tap ‘NO’ to return to Playback Mode without deleting the selected video. 

 
 
 

 ViviLink Menu (for Videos) 

The ViviLink technology allows you to quickly and easily upload your camera’s photos and videos to 

the social networks of your choice with the accompanying Vivitar Experience Image Manager 

application. 

The ViviLink for Videos Menu Options include: 

  YouTube 

  Photobucket 

  Flickr 

N None 

 

1) Tap MENU to open the Main Menu Screen for the current mode. 

2) Tap the ViviLink menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Main 

Menu Screen. 

5) From the Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Playback Mode.  

6) An icon reflecting your selection displays on the LCD screen. 

This icon appears on the top center of the LCD screen. 
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Camera Setup 

The general settings for your digital camera can easily be changed at any time. 

To enter the Camera Setup Menus: 

1) Press the HOME button to the right of the LCD touch screen to open the Home screen options. 

2)  Tap the Setup icon to enter the Main Menu options for your camera general settings. 

 

The following are the menus that appear in the Camera Setup Menus: 

 

 Language  Frequency 

 Date  Format 

 Silent Mode  Default 

 Auto Off  Touch Correction 

 

 Language Menu 

You can select your camera’s language setting by selecting the desired language from the Language 

menu. 

The Language Menu Options include: 

English Dutch 

French Italian 

Spanish Russian 

Portuguese Turkish 

German  

 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Language menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Setup 

Main Menu Screen. 

5) From the Setup Main Menu Screen: 



 
 

54 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  

 

 

 Date Menu 

The Date/Time menu allows you to set your camera’s date and time as desired.  

When you capture an image with your camera, the image will include a time stamp with the date and 

time that the image was taken. 

You can also disable the timestamp for future images taken with your camera. 

The Date/Time Stamp Menu Options include: 

ON The timestamp will appear on photos taken 

OFF The date stamp will not appear on photos taken 

 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Language menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option to set the time and date. 

4) Tap SAVE & EXIT to select and confirm the date/time and continue to the Time Stamp Menu. 

5) Tap ‘ON’ to enable the Time Stamp or ‘OFF’ to disable the Time Stamp, and then tap Save & Exit 

to select and confirm the highlighted menu option and return to the Setup Main Menu Screen. 

6) From the Setup Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  

 

 

 Silent Mode Menu 

You have the option of activating the camera’s Silent Mode to disable all of the sound effects (except 

for beeps heard during the Self-Timer countdown) that the camera emits when performing camera 

functions. 

NOTE: The camera features that emit sounds include - Power On, Power Off, Shutter ‘Click’ and 

Self-Timer. 

The Silent Mode Menu Options include: 
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ON 
The camera sound effects are deactivated.  

Sounds are not heard for: Power On, Power Off, Shutter ‘Click’ and Self-Timer. 

OFF The camera sound effects are activated and can be heard. 

 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Silent Mode menu icon to open the menu options. 

3) Tap ‘ON’ or ‘OFF’ and then tap SAVE & EXIT to select and confirm the highlighted menu option 

and return to the Setup Main Menu Screen. 

4) From the Setup Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  

 

 

 Auto Off Menu 

You can use the Auto Off feature in order to conserve you camera’s battery life. The designated time 

represents when your digital camera will automatically power off.  

When the camera sits idle for the designated period of time, the camera will shut off completely and 

will need to be turned on again with the power button before the next use. 

The Auto Off Menu Options include: 

1 minute 

3 minutes 

5 minutes 

Disable 

 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Auto Off menu icon to open the menu options. 

3) Drag up or down to scroll and highlight the desired menu option. 

4) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Setup 

Main Menu Screen. 

5) From the Setup Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  
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 Frequency Menu 

The options in the Frequency menu represent the frequency of the electrical current in fluorescent 

lighting sources in your locale. If your camera is set to a frequency that does not match your country’s 

electric current, you may see flickering or waves on the images taken by your camera. 

The Frequency Menu Options include: 

50HZ UK, Europe and Australia 

60HZ US, Canada and South America 

 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Frequency menu icon to open the menu options. 

3) Tap ‘50HZ’ or ‘60HZ’ and then tap SAVE & EXIT to select and confirm the highlighted menu option 

and return to the Setup Main Menu Screen. 

4) From the Setup Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  

 

 

 Format Menu 

You can use the Format SD Card menu to delete all of the content that is currently on your camera’s 

memory card.  

Keep in mind that formatting the memory card will permanently delete all of the content on 

your camera’s memory card.  

This option will delete all of the content at one time. If you would like to delete individual images, use 

the delete menu in the camera’s Playback Mode. 

The Format Menu Options include: 

YES Formats SD memory card. All videos and photos deleted. 

NO Does not format SD memory card. 

 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Format menu icon to open the menu options. 
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3) Tap ‘YES’ to automatically format the SD memory card. 

Tap ‘NO’ to automatically return to the Setup Main Menu Screen without formatting. 

4) From the Setup Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  

 

 

 Set Defaults Menu 

Use this menu to reset your camera settings to the Factory Default Settings. 

The Set Defaults Menu Options include: 

YES Reset camera settings to Factory Default Settings 

NO Does not reset and maintains the current camera settings. 

 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Set Defaults menu icon to open the menu options. 

3) Tap ‘YES’ to automatically reset to the Factory Default Settings.  

Once the reset is complete the following text appears on the LCD: ‘Setting reset complete’ 

Tap ‘NO’ to automatically return to the Setup Main Menu Screen without resetting the camera 

settings. 

4) From the Setup Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  

 

 

 Touch Correction Menu 

Use this menu to reset the LCD Touch screen calibration. 

1) Press the HOME button and then tap the Setup icon.  

2) Tap the Touch Correction menu icon to open the menu options. 

3) Follow the instructions on the LCD screen: 

- ‘Please touch Top-Left red point.’ 
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- ‘Please touch Bottom-Right red point.’ 

Once the calibration is complete the Setup Main Menu Screen appears. 

4) From the Setup Main Menu Screen: 

 Tap another menu icon to select a different menu item. 

 Tap Return to return to the Home Menu screen.  

 

 

 

Slide Show 

You can play back all images recorded on your SD memory card.  

1) Press the HOME button and tap the  Slide Show icon. 

2) Tap the Play icon in the center to start the Slide Show. 

Tap and touch the screen to stop or pause the Slide Show. 

3) Tap the MENU icon to set the interval length of time that each picture will display during the Slide 

Show. 

4) Drag up or down to scroll and highlight the desired menu option. 

The Slide Show Interval Options include: 

3 Seconds  5 Seconds  10 Seconds 

5) Tap SAVE & EXIT to select and confirm the highlighted menu option and then return to the Slide 

Show screen. 

Tap the Play button to begin the Slide Show. 

6) Press the HOME button to exit the Slide Show and return to the Home Main Menu screen. 

 

 

Power Off 

1. Press the HOME button and tap the  Power Off icon. 

2. Tap ‘Yes’ to confirm or tap ‘No’ to return to the Home Main Menu Screen. 
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Installing the Software 

You must be connected to the internet to install and run the Vivitar Experience Image Manager 

software. 

 

1) Insert the installation CD into your CD-ROM drive. The installation screen should automatically 

open.  

 

2) On PC: The Vivitar Experience Image Manager Installer window appears. If the window does not 

appear, open the application’s CD/DVD drive and click on “Setup.exe” to launch the installer. 

3) On Macintosh: Click the icon that appears on the desktop to install the Vivitar Experience Image 

Manager. 

4) If you do not have internet access at the time of inserting the CD-ROM, connect to the internet and 

then click the “Install Vivitar Experience Image Manager” button to begin the installation. 

 

 

NOTE: If you do not have internet access, you can still download media from the camera. Click the 

“How to transfer photos and videos from my camera to my computer” button for instructions. 
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5) If you have internet access, the “Choose your language” window opens, choose your language 

and click “Next” to open the next window. 

6) Select your camera model from the list and click “Next” to open the next window. 

7) Click “Next” to confirm your camera model selection and to install the application. 

8) Please wait while the application is being installed on your computer.                     

9) Please review the license terms. 

On PC and Macintosh: Click the “I accept the terms of this license agreement” and then click 

“Next” to continue. 

10) On PC only: Let the “Vivitar Experience Image Manager” installer create the folder to where the 

program will be installed, and then click “Install”.  

11) Please wait while the application continues the installation process on your computer. 

12) On PC: Click the “Close” button when the installation is complete. 

The application will automatically open. 

13) On Macintosh: Click the “Quit” button when the installation is complete. 

Click the “Launch Vivitar Experience Image Manager” to open the application 

14) If you close the application you can run the Vivitar Experience Image Manager from the 

Programs (PC) or Application (Mac) menu on your computer.  

 

 

 

 

Connecting the Camera to the Computer 

1) Use the USB cable that came with your camera to connect your camera to your computer. 

2) Power the camera on. 

3) The first time you connect the device to the computer you will have to wait a few seconds until the 

computer recognizes the device. 
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Getting Photos and Videos from Your Camera to Your Computer 

An SD card needs to be inserted. Do not disconnect the cable during transfer. Doing so will cancel the 

transfer of any files on their way to your computer. 

1) Select the “Get Images” button from the Main menu. 

 

2) The “Get Images from device” window opens. 

3) You can select to download photos, videos or both. 

4) Select your camera (removable disk) from the device window. If your camera is the only USB 

device connected then it will be selected automatically. 

5) Select a location on the computer where to place the new photo and video files. 

6) Add the new photo and video files to albums if desired. 

7) Select to remove the media files from the selected device (removable disk) after the import. 

8) Click the “Get Images” button to transfer the photos and videos from your camera to your 

computer. 

9) A media download progress bar appears on the bottom left showing the number of media files 

downloading to your computer. A message appears when the download is complete. 

10) The photo and video files that you selected are now downloaded to your computer to the selected 

folder and albums ready for your use.       
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Get Started! 

Using the Vivitar Experience Image Manager, you can: 

 Upload and manage photos and videos to and from the most popular photo sharing and social 

networking sites - Facebook, Flickr, Picasa, MySpace, Photobucket, Twitpic, Twitgoo and YouTube  

 Seamlessly transfer photos and videos from one social network to another 

 Organize your images by creating offline and online albums  

 Edit images using automatic and manual tools  

 Use automatic “Geotagging” with built in Google Maps 

 

For more details on how to use the Vivitar Experience Image Manager open the ‘Help Guide’ 

from the Help menu or click the “Take a Tour” button on the application’s Home screen. 

 

 

 

Transferring Images from my Camera to my Computer Manually 

 

Transferring Photos and Videos: WINDOWS 

1) Use the supplied USB cable to connect your camera to your computer. 

2) ‘MSDC’ appears on the LCD – indicating that your camera is now connected to the computer as a 

Mass Storage Device. 

3) A window appears with a list of options, select “Open folder to view files” and click ‘OK’. 

4) Open the DCIM folder and the folder inside to view the media files. 

5) Select the media and copy the files from this folder into your computer. Alternatively, select the 

files and choose ‘Copy’ from the Edit menu. Then select a folder and choose ‘Paste’ from the Edit 

menu.  

6) We recommend that you copy the images into the Pictures/My Pictures folder and the videos into 

the Videos/My Videos folder. 

7) Do not disconnect the USB cable during transfer. Doing so will cancel the transfer of any files on 

their way to your computer. 
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Transferring Photos and Videos: MACINTOSH 

1) Use the supplied USB cable to connect your camera to your computer. 

2) ‘MSDC’ appears on the LCD – indicating that your camera is now connected to the computer as a 

Mass Storage Device. 

3) The camera’s device icon appears on the desktop. 

4) Click on the device icon and open the DCIM folder and the folder inside to view the media files. 

5) Select the files and drag them into your computer. Alternatively, select the files and choose 

‘Copy’ from the Finder’s Edit menu. Then select a folder and choose ‘Paste’ from the Edit menu. 

6) We recommend that you copy the images into the Pictures folder and the videos into the Movies 

folder. 

7) Do not disconnect the USB cable during transfer. Doing so will cancel the transfer of any files on 

their way to your computer. 

 

 

 

 

Transferring Photos and Videos:  Apple iPad 

NOTE: Please check your device packaging for compatibility with the iPad. 

 

Apple iPad Camera Connection: 

For models that are compatible with the iPad, photos and videos can be imported from your digital 

camera to your iPad by following either one of the options below: 

1) Connecting your digital camera to your iPad using an iPad Camera Connector: 

Plug the Camera Connector into the dock connector port on your iPad, and then attach your digital 

camera using a USB cable (included) to the Camera Connector. 

NOTE: The iPad Camera Connector is not included. This item may be purchased separately. 

2) Using an iPad SD Card Reader: 

Connect the SD Card Reader to your iPad, and then insert your digital camera's SD Memory card 

into the slot to import photos and videos directly from your camera's SD card. 

NOTE: The iPad SD Card Reader is not included. This item may be purchased separately. 

 

After you make the connection, your iPad automatically opens the ‘Photos’ application. This allows you 

to choose which photos and videos to import and to organize them into albums. 
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Camera Maintenance 

The digital camera is a delicate device. Please handle your digital camera with care to avoid  

damaging it. 

Do not expose your digital camera to heat sources. 

Do not use you digital camera in wet or moist conditions. 

 

Sakar Warranty Card 

This warranty covers for the original consumer purchaser only and is not transferable. Products that 

fail to function properly UNDER NORMAL USAGE, due to defects in material or workmanship will be 

repaired at no charge for parts or labor for a period of one year. 

 

What Is Not Covered By Warranty: 

Damages or malfunctions not resulting from defects in material or workmanship and damages or 

malfunctions from other than normal use, including but not limited to, repair by unauthorized parties, 

tampering, modification or accident. 

 

What To Do When Service Is Required: 

When returning your defective product (postage pre-paid) for service, your package should include: 

1) Copy of original bill of sale. 

15) A detailed written description of the problem. 

16) Your return address and telephone number (Daytime). 

 

MAIL TO ADDRESS BELOW: 

Sakar US 

Sakar International 

Attention: Service Department 

195 Carter Drive 

Edison, NJ  

08817 

 

Sakar UK/Europe 

Attention: Service Department 

2D, Siskin Parkway East 

4020 Middlemarch Business Park 

Coventry, CV3 4PE 

 

Sakar Australia 

Return faulty camera 

to the Refund 

Counter at the store 

where purchased 
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Technical Support 

For technical support issues please visit our website at www.vivitar.com. You can find manuals, 

software and FAQ’s at the website. Can’t find what you are looking for? E-mail us at 

support@vivitar.com and one of our technical support team members will answer your questions. 

For phone support in the US please call 1-800-592-9541, in the UK call 0800 917 4831, in Australia 

call 1800-006-614.  If you would like to call from anywhere else, please visit www.vivitar.com for 

your local toll free number.  

 

 

Troubleshooting 

Q: I have taken photos and selected the “Get Images” button. I get a message that the images 

were successfully transferred but the photos do not appear on my computer.  What do I do? 

First ensure that you have in fact taken photos. Press the Shutter button to take some sample photos 

and then try downloading them again. 

With test photos if the camera powers off before you upload them to the computer the photos are not 

stored in the camera’s memory. These photos should be uploaded quickly before the camera powers 

off.  

If the photos are saved to the SD memory card then all the photos should appear. 

  

Q: How do I make sure I don’t lose important pictures? 

This camera requires an SD card for normal use. If the camera powers off nothing will happen to the 

images stored on the SD memory card. We recommend always downloading your photos to your 

computer as soon as possible to prevent unintentional data loss.     

 

Q: I deleted images using the Vivitar Experience Image Manager. The images were also deleted 

from my computer. How do I recover images that I accidently deleted? 

All images deleted using the Vivitar Experience Image Manager are sent to your computer ’s Recycle 

or Trash Bin and can be retrieved from there.           
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